


ถงึแมในปจจบุนัการแตงภาพจะกลายเปนเรื่องงาย จากการเขามาของแอพพลเิคชนั

ที่ทาํใหทกุอยางสาํเรจ็ไดในไมกี่จึ้ก (จึ้ก คอื หนวยของการจิ้มหนาจอสมารทโฟน)

แลวทาํไมพวกเรายงัพยายามหนามนึที่จะทาํหนงัสอืสอนรทีชัภาพดวย Photoshop 

ออกมากนัอกีนะ

ถามกลบังายๆ เลยครบั “แอพพลเิคชนัพวกนั้นมนัตอบทกุจนิตนาการไดหรอืเปลา” 

ใชครบั ไมได

เมื่อเรยีนจบมาหรอืเมื่อตองทาํงาน คงไมมใีครใชแอพฯ ทาํงานสาํหรบัสงงานให

ลูกคาหรอก จรงิไหมครบั

แลวจะเอาอะไรฝก Photoshop ดนีะ

นั่นละครบัที่มาของหนงัสอืเลมนี้ ฝกรทีชั ตดัตอ ใชเครื่องมอืตางๆ ของ Photoshop 

สรางภาพที่เหนอืจนิตนาการขึ้นมา สิ่งที่จะไดแนๆ กค็อื จะมหศัจรรยใจไปกบัเทคนคิการ

ใชเครื่องมอื คาํสั่งซึ่งสิ่งตางๆ เหลานี้จะเปนเทคนคิตดิตวัไปใชงานในอนาคต และตอบ

โจทยจนิตนาการของเราเอง นอกจากนั้นยงัทาํใหเราเกดิความคุนเคยกบัการประยกุตใช

งาน ซึ่งจะทาํใหจนิตนาการครั้งตอไป กวาง และไรขอบเขตมากยิ่งขึ้น

ขอใหสนกุกบัการรทีชัและการประยกุตใชเครื่องมอืจากหนงัสอืเลมนี้

ขอบคณุครบั

ปยะบตุร สทุธดิารา
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การรีทัชภาพใหสวยงามอลังการอาจเปนเรื่องที่ใครหลายคนคิดวาไกลตัวเกินไป 

ใช Photoshop ไมเกงคงทาํไมไดแนนอน 

ความคดินี้อาจไมถูกตองทั้งหมด เพราะความจรงิแลวการรทีชัภาพนั้น 

“เครื่องมอืและคาํสั่งอาจไมสาํคญัเทาจินตนาการ”

หนังสือเลมนี้จะพาผูอานไปทําความรูจักกับเครื่องมือ และคําสั่งที่มหัศจรรยของ 

Photoshop เพียงไมกี่อยางก็สามารถพลิกแพลงการใชงานเพื่อสรางเอฟเฟกตใหภาพ

ออกมาสวยงามอลงัการได

หนงัสอืเลมนี้จงึเหมาะกบัทกุคนที่มคีวามหลงใหลการรทีชัภาพ และตองการพฒันา

ฝมอืในการสรางสรรคผลงานใหออกมาสมบูรณที่สดุ

สดุทายนี้ผูเขยีนหวงัไวเปนอยางยิ่งวา หนงัสอืเลมนี้จะมปีระโยชนกบัผูอานไมมาก

กน็อย หากมขีอผดิพลาดประการใด ตองขออภยัไว ณ ที่นี้ดวย
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Essential Photoshop Skills
Intro

Photoshop มีเครื่องมือและคําสั่งการทํางานมากมาย แต่ในการใช�งานจริงต่อให้งานมีความซับซ�อนแค่ไหน 
แต่ก็มีเครื่องมือไม่กี่ตัวหรือไม่ก่ีคําสั่งเท่านั�นที่เราต้องใช�อยู่เสมอ ซ่ึงหนังสือเล่มนี�จะสอนให้ผู้อ่านได้สร้างสรรค์ผล
งานการรีทัชภาพให้ออกมาสวยงามอลังการด้วยเครื่องมือและคําสั่งไม่กี่อย่าง

และเนื�อหาในบทนี�ผู้เขียนไดร้วบรวมเครื่องมอืและคาํสั่งที่จาํเป�นตอ่การใช�งาน รวมไปถงึเทคนคิการใช�งานตา่งๆ
เพื่อให้การทํางานสะดวกมากยิ่งขึ�น ซ่ึงศึกษาได้จากหัวข้อต่างๆ ต่อไปนี�

Essential Photoshop 
Skills

Intro

2
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การรีทัชเพื่อลบจุดบกพรองเบื้องตน
สิ่งแรกที่ต้องเรียนรู้สําหรับการทํางานใน Photoshop ไม่ว่าจะเป�นเวอร์ชันใดก็ตามคือ วิธีรีทัชเพื่อลบหรือแก้ไขจุด

บกพร่องของภาพ และคงไม่มีเครื่องมือใดที่ทรงประสิทธิภาพและได้รับความนิยมเท่ากับเครื่องมือ  (Clone Stamp Tool) 
และ  (Spot Healing Brush Tool) ซ่ึงเราจะมาทําความรู้จักกับเครื่องมือทั�ง 2 นี�อย่างละเอียดกัน

รีทัชแกไขจุดบกพรองดวยเครื่องมือ Clone Stamp Tool
 (Clone Stamp Tool) เป�นเครื่องมือดั�งเดิมของ Photoshop ที่มีให้ใช�งานในทุกเวอร์ชัน จุดเด่นของเครื่องมือนี�

คือสามารถนําพื�นท่ีจุดที่ต้องการมาแปะทับบริเวณท่ีมีปัญหาได้ ซ่ึงการใช�งานให้ได้ผลลัพธ์ที่ดีนั�นจะต้องปรับค่าของ
เครื่องมือให้เหมาะสม ซ่ึงค่าการปรับแต่งที่สําคัญของเครื่องมือ  (Clone Stamp Tool) มีดังนี�

กําหนดขนาดและ
ความฟุงของเครื่องมือ

กําหนดโหมดการผสมสีของพื้นที่ตนฉบับ 
และจุดที่ตองการแปะทับ

กําหนดใหสีเขมขึ้นเมื่อแดรกเมาส
ที่จุดเดิมซ้ําๆ

กําหนดน้ําหนักของเครื่องมือ
ในการใชงานแตละครั้ง

เลือกออปชันการรีทัช
เมื่อทํางานหลายเลเยอร

กําหนดความเขมตามน้ําหนัก
การกดเมื่อใชกับ Tablet

สาํหรบัแนวทางการใช�งานเครื่องมอื  (Clone Stamp Tool) นั�น เรา
จะต้องวิเคราะห์ความบกพร่องของภาพเสียก่อนว่ามีจุดบกพร่องบริเวณใด
และจะสามารถนําพื�นที่ใดมาแปะทับได้บ้างดังภาพตัวอย่าง หากต้องการ
รีทัชเสาไฟและสายไฟด้านข้างออกจะต้องนําท้องฟ�าและพื�นท่ีใกล้เคียงมา
แปะทับนั่นเอง

เมื่อวิเคราะห์เบื�องต้นได้แล้วก็เข้าสู่ขั�นตอนการทํางาน โดยเราจะเริ่มต้น
โดยปรับค่าเครื่องมือ  (Clone Stamp Tool) ก่อน ซ่ึงหัวใจสําคัญอยู่ที่

ขนาดและค่า Hardness 

ตัวอยางการกําหนดคาใหเครื่องมือ  (Clone 
Stamp Tool) โดยกําหนดคา Hardness เปน 0% 
เพื่อใหเครื่องมือมีขอบแบบฟุง ซึ่งจะชวยใหการรีทัชมี
ความกลมกลืนมากขึ้น

สําหรับค่า Hardness มักกําหนดเป�น 
0% เพื่อให้เครื่องมือมีขอบฟุ้ง ซ่ึงจะช่วยให้
ได้ผลลัพธ์ท่ีกลมกลืนกว่า (การกําหนดค่า 
Hardness สูงๆ มักใช�ในกรณีที่รีทัชภาพที่มี
รายละเอียดเลก็ๆ และมพีื�นท่ีไมก่วา้งมากนกั) 
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สําหรับขนาดของเครื่องมือ  (Clone Stamp Tool) สามารถกําหนดได้ง่ายๆ โดยกดปุ่ม  เมื่อต้องการลดขนาด 
หรือกดปุ่ม  เพื่อเพิ่มขนาดเครื่องมือ

อีกค่าหนึ่งที่สําคัญ ได้แก่ ค่า 
Opacity หรือนํ�าหนักของเครื่องมือ 
การกาํหนดค่านั�นใหพ้จิารณาจากพื�นท่ี
การทํางาน หากมีรายละเอียดไม่ชัดเจน 
หรือเป�นพื�นที่โล่งๆ เช่น ท้องฟ�า ก็ควร
ลดค่า Opacity ให้ตํ่ากว่า 50% แต่
หากภาพมีรายละเอียดคมชัด ขอบเขต
ชัดเจนกค็วรเพิ่มคา่ Opacity ใหส้งูเพื่อ
ให้การรีทัชออกมาคมชัดเหมือนภาพ
ต้นฉบับนั่นเอง

เมื่ อกํ าหนดค่าให้ เค ร่ืองมือ
เรียบร้อยแล้ว ก็เข้าสู่การทํางานซ่ึง
จะมีหลักการอยู่ว่า เราจะต้องกดปุ่ม  

 แล้วใช�เครื่องมือ  (Clone 
Stamp Tool) คลิกไปยังพื�นที่ต้นฉบับ
เพื่อก็อปปี� เสียก่อน 

ตัวอยางการกําหนดคา Opacity โดยลดลงเหลือ 50% เนื่องจากบริเวณที่มีปญหามีรายละเอียด
ไมมากนัก หากใชคา Opacity สูงไปจะทําใหสีสันไมสมํ่าเสมอ

เมื่อเลื่อนเมาส์ไปจุดที่มีปัญหา 
ซ่ึงจะปรากฏพื�นที่ที่ เราก็อปปี� ไว้จาก
ขั�นตอนที่ผ่านมาด้วย ก่อนท่ีจะคลิก
ลงไปให้พิจารณาก่อนว่ามีสีสันใกล้
เคียงกับจุดที่มีปัญหาหรือไม่ 

หากตรวจสอบแล้วมีสีสันใกล้
เคียงกันก็ให้คลิกเพื่อแปะทับลงไป ซ่ึง
เราสามารถคลิกซํ�าๆ 2-3 ครั�งจนกว่า
จุดที่ เป�นปัญหาจะถูกลบไปดังภาพ
ตัวอย่าง 

เราสามารถแดรกเมาส์ไปยังจุด
อื่นๆ ของภาพเพื่อแก้ไขจุดที่บกพร่อง 
แต่หากพบว่าพื�นที่ต้นฉบับและจุดที่

เป�นปัญหามีสีสันของภาพแตกต่างกัน
จนเกินไปก็ให้กดปุ่ม  แล้วใช�
เครื่องมือ  (Clone Stamp Tool) 
คลิกไปยังพื�นที่ ใหม่ แล้วจึงนําไป
เกลี่ยทับจุดที่เป�นปัญหา
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แกไขจุดบกพรองเล็กๆ ดวยเครื่องมือ   Spot Healing Brush Tool
 (Spot Healing Brush Tool) เป�นเครื่องมือที่สามารถรีทัชภาพเพื่อแก้ไขจุดบกพร่องได้เช่นกัน โดยจุดเด่นจะอยู่ที่

เครื่องมอืตวันี�จะนาํพื�นผิวบรเิวณรอบข้างมาเกลี่ยทบัจุดที่เป�นปัญหา แตอ่าจจะไมเ่หมาะกบัการรทีชัพื�นที่ขนาดใหญ ่หรอืพื�นที่

ที่มีรายละเอียด แสง สีแตกต่างกันมากเกินไป ซ่ึงก่อนการใช�งานจะต้องกําหนดค่าของเครื่องมือให้เหมาะสม ดังนี�

กําหนดขนาดของ
เครื่องมือ

กําหนดใหนําพื้นที่รอบ
ขางมาเกลี่ยเปนสีใหม

เลือกโหมดการผสานสีของ
เครื่องมือ

กําหนดใหนําพื้นผิว
มาสรางเปน Pattern

กําหนดใหเติมพื้นผิวแบบคํานวณ
จากจุดรอบดาน

ใหนําจุดที่แกไขมาเก็บไวบน
เลเยอรใหม

เมื่อต้องรีทัชแก้ไขจุดที่มีรายละเอียดชัดเจน ก็ให้ลด
ขนาดเครื่องมือลง พร้อมเพิ่มค่า Opacity ให้สูงขึ�น หรือ
อาจจะเพิ่มค่า Hardness ขึ�นอีกเพื่อให้ขอบเขตคมชัดเหมือน
เดิม  เมื่อเรียบร้อยแล้วก็จะได้ผลลัพธ์ดังภาพ

อย่างไรก็ตามมีอีก 1 สิ่งที่ต้องให้ความสําคัญคือ 
การใช�เครื่องมือ  (Clone Stamp Tool) รีทัชภาพนั�น
จะเป�นการแก้ไขภาพโดยตรง หากเกิดความผิดพลาดอาจ
แกไ้ขยากขึ�น เราสามารถป�องกันปัญหานี�ไดโ้ดยเลอืกออปชัน 
Sample All Layers บนออปชันบาร์

หลังจากนั�นสร้างเลเยอร์ว่างๆ ไว้ด้านบนสุด เมื่อใช�
งานเครื่องมือ  (Clone Stamp Tool) รีทัชภาพก็จะ
เป�นการคัดลอกพื�นผิวมาเก็บไว้บนเลเยอร์ว่างนี� ทําให้ภาพ
ต้นฉบับไม่เสียหายจากการทํางานนั่นเอง
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การใช�งานเครื่องมือ  (Spot Healing Brush Tool) ไม่มีอะไรซับซ�อนเหมือนเครื่องมือ  (Clone Stamp Tool) 
เพียงแค่สร้างเลเยอร์ว่างๆ ไว้ด้านบน พร้อมกับเลือกออปชันของเครื่องมือแบบ Content-Aware และคลิกเลือก Sample All 
Layers เพื่อป�องกันความผิดพลาดที่อาจเกิดขึ�นกับภาพต้นฉบับ 

เมื่อกําหนดค่าเรียบร้อยแล้วก็
ให้ใช�เครื่องมือคลิก หรือแดรกเมาส์
ไปยังจุดที่ต้องการแก้ไข เพียงเท่านี�
จุดบกพร่องที่ เราไม่ต้องการก็จะถูก
เกลี่ยทับดว้ยพื�นท่ีรอบขา้งโดยอัตโนมติั

ถึงแม้ว่าเครื่องมือ  (Spot 
Healing Brush Tool) จะใช�งานงา่ย แต่
ก็มีข้อจํากัดเม่ือต้องทํางานกับบริเวณ
ที่ มีความแตกต่างของสี หรือความ
สว่างมากๆ อาจให้ผลลัพธ์ท่ีไม่ดีนัก 
ซ่ึงอาจต้องใช�เครื่องมือ  (Clone 
Stamp Tool) เข้ามาช่วยด้วย

ขอจํากัดของเครื่องมือ  (Spot Healing Brush Tool) เมื่อรีทัชบริเวณที่มีความแตกตาง
มากๆ (ภาพซาย) ซึ่งจะเห็นวาภาพเกิดความเสียหาย ดังนั้น หากตองการรีทัชบริเวณที่รายละเอียด
มากๆ แบบนี้ควรใชเครื่องมือ  (Clone Stamp Tool) จะใหผลลัพธที่ดีกวา (ภาพขวา)
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สารพัดเทคนิคตัดวัตถุออกจากฉากหลัง
การตัดต่อภาพให้ออกมาสมจริงนั�น หัวใจสําคัญส่วนหนึ่งจะอยู่ที่การสร้าง Selection เพื่อตัดภาพออกจากฉากหลัง 

แลว้นาํไปใช�งานรว่มกบัภาพอ่ืนๆ ซ่ึงการ Selection นั�นทําไดห้ลากหลายวธิ ีมเีครื่องมอืเป�นสบิแบบที่ใช�ในการสรา้ง Selection 
ได้ แต่ในหัวข้อนี�เราจะมาทําความรู้จักวิธีวิเคราะห์รูปแบบของภาพ และการเลือกเครื่องมือให้เหมาะสมในการทํางาน ดังนี� 

ตัดฉากหลังอยางงายดวยเครื่องมือ Magic Eraser Tool
 (Magic Eraser Tool) เป�นเครื่องมือที่ใช�ตัดฉากหลังให้ภาพแบบง่ายๆ แต่จะเหมาะกับภาพที่มีฉากหลังเป�นสีพื�น 

เช่น ท้องฟ�าที่ไม่มีรายละเอียดมากนัก แต่ควรมีสีสันแตกต่างจากวัตถุหลักในภาพพอสมควร เนื่องจากเครื่องมือจะวิเคราะห์ 
และลบขอบเขตที่มีสีสันใกล้เคียงกันออกไปด้วย ซ่ึงการใช�งานเครื่องมือให้ได้ผลลัพธ์ที่เหมาะสม  (Magic Eraser Tool) 
ควรปรับค่าต่างๆ ต่อไปนี�

01 หลงัจากที่เลอืกเครื่องมอื  (Magic Eraser Tool)

แลว คาแรกที่ตองปรับคา Tolerance ซึ่งเปน

คาความตอเนื่องของสี หากกําหนดคาสูงจะทําใหเมื่อคลิก

เครื่องมือลงไปแลวสีที่แตกตางกันจะถูกลบออกไปดวย แต

หากกําหนดคาตํ่าก็จะเปนการลบเฉพาะสีที่ใกลเคียงกัน

เทานั้น

คลกิเลอืก Anti-alias คอื การปรบัลกัษณะเสนขอบของ

วัตถุไมใหเปนรอยหยัก และคลิกเลือก Contiguous หาก

ตองการลบเฉพาะขอบเขตที่ตดิกนัเทานั้น

02 หลังจากที่กําหนดคาใหเครื่องมือเรียบรอยแลว 

เมื่อคลิกไปบนทองฟา ซึ่งเปนสีพื้นก็จะพบวา

ฉากหลังนั้นถูกลบทิ้ง และสามารถก็อปปภาพเพื่อนําไป

ใชงานไดทนัท ี
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ตัดฉากหลังโดยอางอิงจากสีดวยคําสั่ง Color Range
คําสั่ง Color Range เป�นคําสั่งที่ใช�สําหรับเลือกขอบเขตในการทํางานโดยอ้างอิงจากโทนสีและความสว่าง ซ่ึงภาพ

ที่เหมาะในการใช�งานด้วยคําสั่งนี�คือภาพที่มีฉากหลังเป�นสีพื�นเรียบๆ แต่เราจะสามารถควบคุมขอบเขตได้ยืดหยุ่นกว่าการใช�
เครื่องมือ  (Magic Eraser Tool) ซ่ึงการใช�งานคําสั่ง Color Range ทําได้ดังนี�

03 เลอืกเครื่องมอื  (Add to Sample) หลงัจากนั้น

คลกิไปบนจดุตางๆ จนฉากหลงัเปนสขีาวทั้งหมด 

เมื่อเรยีบรอยแลวปรบัคา Fuzziness เพื่อควบคมุขอบเขตให

อยูในพื้นที่ที่ตองการ

02 คลกิเมนู Select > Color Range เพื่อเปดคาํสั่ง 

หลงัจากนั้นใชเครื่องมอื  (Eyedropper Tool) 

คลิกไปบนฉากหลังที่ตองการตัดทิ้ง ผลที่ไดคือปรากฏพื้นสี

ขาวบนหนาตางคาํสั่ง แตยงัไมครอบคลมุพื้นที่ทั้งหมด

04 คลิกเลือก Invert เพื่อสลับดานใหฉากหลังเปน

สดีาํกอนแลวจงึคลกิปุม OK เพื่อทาํงานขั้นตอไป

01 ตวัอยางภาพถายที่มฉีากหลงัเปนสพีื้น แตเราจะ

เห็นวามีรายละเอียดของเสนผมอยูดวย หากใช

เครื่องมอื  (Magic Eraser Tool) อาจทาํใหรายละเอยีด

สวนนั้นเสยีหายไปดวย
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05 เมื่อกลบัเขาสูหนาจอการทาํงานปกต ิจะปรากฏ 

Selection รอบจดุที่เราตองการ ซึ่งสามารถกอ็ปป

เพื่อนาํไปใชงาน หรอืสามารถคลกิปมุ  (Add layer mask) 

เพื่อซอนขอบเขตของฉากหลงัไปกอนกไ็ด

สาํหรบัการสราง Layer Mask นั้นจะเปนวธิซีอนขอบเขต

ที่อยูนอก Selection แตสามารถเพิ่ม-ลด หรอืปรบัปรงุใหมได 

เนื่องจากไมไดเปนการตัดภาพทิ้งไปจริงๆ ซึ่งในการรีทัชตัด

ตอภาพ Layer Mask จะมีประโยชนมาก และเราจะมาทาํ

ความรูจกักบั Layer Mask ในหวัขอตอๆ ไป

ตัดภาพรายละเอียดมากๆ จากฉากหลังดวยเครื่องมือ Pen Tool
สําหรับภาพที่มีขอบเขตไม่ชัดเจน มีเหลี่ยมมุม รอยโค้งเว้ามากๆ และสีของฉากหลังไม่ใช่สีพื�น การเลือกทํางานกับพื�นที่

ลักษณะนี�จะต้องใช�งานเครื่องมือที่มีความสามารถในการกําหนดขอบเขตที่แม่นยํา 
ถึงแม้ว่าเครื่องมือ  (Pen Tool) มักถูกนําไปใช�สร้างเส้น Path แต่เราสามารถเปลี่ยนเส้น Path เหล่านั�นให้กลายเป�น

Selection ได้ ซ่ึงมีหลักการใช�งานดังนี�

01 จากภาพตวัอยางจะเหน็วา ภาพลกัษณะนี้จะไม

สามารถตัดฉากหลังออกไดดวยวิธีการที่ผานมา

การใชเครื่องมอื  (Pen Tool) ถอืวาเหมาะสมที่สดุ

02 หลงัจากที่เลอืกเครื่องมอื  (Pen Tool) แลว

ใหคลกิเลอืก Path บนออปชนับารเพื่อสรางเสน 

Path โดยไมตองเตมิสลีงในรูปทรงที่สรางขึ้น
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03 ใชเครื่องมอื  (Pen Tool) คลกิไปบรเิวณขอบ

ของภาพเพื่อสรางเสน Path สาํหรบับรเิวณที่เปน

สวนโคงของภาพใหใชวิธีคลิกแลวแดรกเมาส ซึ่งจะชวยให

เสน Path โคงรบักบัรูปทรงได

04 เมื่อสรางเสน Path คลุมรูปทรงจนรอบแลวให

คลิกขวาแลวเลือกคําสั่ง Make Selection แลว

กาํหนดคา Feather Radius ซึ่งคานี้จะเปนตวักาํหนดความ

ฟุงใหขอบของ Selection

แตเครื่องมอืนี้อาจมขีอจาํกดัหากตองสราง Selection ให

กับภาพที่มีสวนโคงเวามากๆ รวมไปถึงเราจะไมสามารถ

ปรบัปรงุขอบเขต Selection ในขณะที่ทาํงานได ซึ่งตางจาก

เครื่องมอื   (Pen Tool) ที่มคีวามยดืหยุนมากกวา

การใชเครื่องมือ  (Polygonnal Lasso Tool) สราง Selection 
จะเหมาะกับภาพที่ลักษณะเหลี่ยมๆ มากกวาภาพที่มีสวนโคงเวามากๆ

05 เมื่อเรียบรอยแลวเราก็สามารถตัดฉากหลังทิ้ง 

หรอืกอ็ปปภาพเพื่อนาํไปใชงานตอไดทนัที

นอกจากเครื่องมอื  (Pen Tool) แลวยงัมเีครื่องมอื

อื่นๆ ที่สามารถสราง Selection ในลกัษณะเดยีวกนัได เชน

เครื่องมอื  (Polygonnal Lasso Tool) 
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ตัดตอ เปลี่ยนฉากหลังภาพดวย   Layer Mask 
Layer Mask คือ วิธีการสร้าง Selection แบบหนึ่ง แต่เป�น Selection ที่สามารถปรับแต่งขอบเขตในภายหลังได้ Layer 

Mask จะมีลักษณะเหมือนกบัการเจาะหรอืตดัเลเยอรใ์หเ้ป�นรู โดยการเจาะหรอืตดันั�นจะทาํไดด้ว้ยการระบายสดีาํลงไปใน Layer 
Mask เพื่อซ่อนพื�นที่ และใช�สีขาวระบายลงไปเพื่อแสดงพื�นที่ตามปกติดังภาพตัวอย่าง

การสรา้ง Layer Mask ทาํไดห้ลาย
วิธี ไม่ว่าจะเป�นการสร้าง Selection 
ก่อน แล้วคลิกปุ่ม   (Add layer 
mask) ซ่ึงพื�นที่นอก Selection จะถูก
ซ่อนไปทันที แต่วิธีนี�จะเหมาะกับภาพ
ที่สามารถสร้าง Selection ง่ายๆ ได้

เมื่อเรานําภาพใหมมาวางไวใตเลเยอรที่สราง 
Layer Mask ไว ก็จะไดภาพที่ดูสวยงามขึ้น

ดวยวิธีงายๆ

ตัวอยางการนําภาพถายมาซอนกัน (ภาพซาย) แลวสราง Layer Mask ใหภาพในเลเยอรบน พรอมกับระบายสีดําเพื่อซอนบริเวณทองฟา จะเห็นวา
ขอบเขตถูกซอนไป (ภาพกลาง) และภาพผลลัพธเมื่อวางภาพซอนบนเลเยอร Background (ภาพขวา)

ตัวอยางภาพถายที่มีขอบเขตชัดเจนอยูแลว 
ซึ่งเราสามารถสราง Selection บริเวณ

ทองฟาไวกอนดวยคําสั่ง Color Range และ
เมื่อคลิกปุม  (Add layer mask) ก็จะ

เห็นวาทองฟาถูกซอนไปทันที
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อย่างไรก็ตามหากภาพที่นํามาใช�นั�นยากต่อการสร้าง Selection เน่ืองจากขอบเขตท่ีไม่ชัดเจน หรือเม่ือเราต้องการ
ผสานขอบเขตของแต่ละภาพที่นํามาตัดต่อกันมีความกลมกลืนกันนั�น เครื่องมือ  (Brush Tool) จะเข้ามามีบทบาทมากขึ�น

01 สําหรับขั้นตอนการสราง Layer Mask วิธีนี้จะ

เริ่มตนโดยนาํภาพที่ตองการตดัตอรวมกนัมาวาง

ซอนบนพาเนล Layers หลงัจากนั้นคลกิปุม  (Add layer 

mask) เพื่อสราง Layer Mask ใหเลเยอรที่ตองการปรบัแตง

เมื่อคลิกปุม  (Add layer mask) แลวจะปรากฏกรอบ
สีขาวดานหลัง ซึ่งกรอบสีขาวนี้คือพื้นที่การทํางานของเรา 

02 เมื่อไดกรอบ Layer Mask แลว ขั้นตอไปใหเลอืกเครื่องมอื  (Brush Tool) พรอมกบักาํหนดคา ซึ่งโดยสวนใหญ

แลว เรามกัจะใชหวัแปรงแบบขอบฟุงเพื่อใหภาพที่ตดัตอมคีวามนุมนวล สวนคา Opacity นั้นควรปรบัตามความ

เหมาะสม หลงัจากนั้นใหเลอืกสโีฟรกราวนเปนสดีาํ เพื่อใชในการซอนขอบเขตสวนที่เราไมตองการใหแสดง

03 เมื่อเราใชเครื่องมือ 

 (Brush Tool) คอื

ระบายสีดําลง ก็จะพบวาพื้นที่

สวนนั้นถูกซอนไปทันที ซึ่งจะ

สอดคลองกับกรอบสีขาวใน 

Layer Mask ที่จะปรากฏพื้นที่

สดีาํที่เราระบายลงไปดวย
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04 ในกรณทีี่เราระบายสดีาํเพลนิเกนิไป จนกนิพื้นที่

เขาไปในจุดสําคัญ ก็สามารถแกไขไดเพียงแค

เปลี่ยนสีโฟรกราวนนี้เปนสีขาวแลวระบายทับลงไป เทานี้ก็

จะสามารถเรยีกคนืพื้นที่นั้นกลบัมาได

05 เมื่อใชเครื่องมอื  (Brush Tool) ระบายสขีาว 

หรอืสดีาํลงไปใน Layer Mask เรยีบรอยแลวกจ็ะ

ไดผลลพัธที่เสรจ็สมบูรณดงัภาพ 

เทคนิคสําคัญของการใชเครื่องมือ  (Brush Tool)

ตดัตอภาพรวมกบั Layer Mask คอื ควรปรบัขนาดเครื่องมอื 

และคา Opacity ใหเหมาะสม

เมื่อตองทาํงานในบรเิวณที่มรีายละเอยีดมากๆ กค็วรลด

ขนาดหวัแปรงใหเลก็ลงโดยกดปมุ  หรอืกดปมุ  เมื่อ

ตองการขยายขนาดหวัแปรงใหใหญขึ้น

สวนคา Opacity นั้นควรลดใหตํ่าลงหากขอบเขตของภาพ

ไมชดัเจนซึ่งจะชวยเกลี่ยใหภาพมคีวามกลมกลนืกนั และควร

เพิ่มขึ้นหากตองการลบพื้นที่เหลานั้นออกไปจากภาพทั้งหมด

เหนือสิ่งอื่นใดคือความอดทนในการทํางาน ยิ่งเรามี

ความละเอยีดรอบคอบมากเทาใด กจ็ะยิ่งชวยใหภาพผลลพัธ

มคีวามสมบูรณสวยงาม

มเีทคนคิอยางหนึ่งที่นาสนใจคอื เครื่องมอื  (Brush 

Tool) จะมีหัวแปรงอยูหลายรูปแบบ ซึ่งเราสามารถเปลี่ยน

หวัแปรงไปเปนแบบตางๆ เพื่อใชงานรวมกบั Layer Mask ได 

เชน เมื่อทํางานกับทุงหญาก็สามารถเลือกหัวแปรงแบบ 

Grass เพื่อซอนหรอืแสดงขอบเขตใหทุงหญาได

ตัวอยางของหัวแปรงแบบตางๆ ที่สามารถนํามาใชรวมกับ Layer 
Mask ได
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Intro

ปรับปรุง Selection ดวย Refine Edge

เลือกรูปแบบแสดงภาพขณะใช
งานคําสั่ง

เลือกเครื่องมือในการทํางาน

ปรับเสนขอบใหนุมนวลขึ้น
ปรับเสนขอบใหฟุงขึ้น

ปรับเสนขอบใหคมชัดขึ้น
เพิ่มหรือลดระยะเสนขอบ

คลิกเครื่องหมายถูกพรอมปรับคา
เพื่อใหคําสั่งตรวจสอบเสนขอบ 
Selection ที่สมบูรณขึ้น

คลิกเครื่องหมายถูกพรอมปรับคา
เพื่อกระจายสีไปยังเสนขอบให
กลมกลืนกับฉากหลังมากขึ้น

เลือกรูปแบบภาพผลลัพธหลังจากปรับปรุง
ขอบเขต Selection เสร็จแลว

การนําภาพถ่ายมาตัดต่อร่วมกันแล้วให้ได้ผลลัพธ์ท่ี
สมจริง การปรับให้เส้นขอบของภาพเนียนเรียบ ไม่ขาดแหว่ง 
หรือมีสีของฉากหลังเดิมติดมาด้วย ถือว่าเป�นจุดเริ่มต้นที่ดี
ในการทํางาน เม่ือมีการปรับปรุงแสงเงา หรือใส่เอฟเฟ�กต์
เพิ่มเติมก็จะทําให้ภาพนั�นออกมาสมบูรณ์ขึ�นได้

ใน Photoshop มีคําสั่งหนึ่งที่เรียกว่า Refine Edge 
ซ่ึงเป�นคําสั่งที่จะช่วยให้เราสามารถปรับปรุง Selection ที่เรา
สรา้งไวใ้หส้มบูรณแ์บบ เมื่อตอ้งการใช�งานสามารถทาํไดโ้ดย
คลิกเมนู Select > Refine Edge หรือคลิกปุ่ม Refine Edge 
บนออปชันบาร์ โดยมีค่าการปรับแต่งที่สําคัญดังนีี� ตัวอยางการตัดตอภาพท่ีมีปญหาเนื่องจากสีของฉากหลังเดิมติดมาตาม

เสนขอบ รวมไปถงึภาพทีข่าดแหวงเน่ืองจากการสราง Selection ทีไ่มดนีกั
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สําหรับแนวทางการปรับปรุง Selection ด้วยคําสั่ง Refine Edge จะเริ่มต้นโดยการสร้าง Selection ไว้ก่อน หลังจาก
นั�นจึงใช�คําสั่ง Refine Edge เข้ามาช่วย ซ่ึงสามารถสรุปเป�นขั�นตอน ดังนี�

02 เมื่อหนาตางคาํสั่งปรากฏขึ้นมาใหเลอืกการแสดง

ภาพแบบ On Layer ซึ่งจะทาํใหเราเหน็ภาพที่เรา

กาํลงัทาํงานอยูบนฉากหลงัจรงิที่เราเตรยีมไว

03 เมื่อกดปมุ  + +  เพื่อซูมภาพเขาไปเราจะ

พบวาบรเิวณเสนขอบของภาพนั้นจะมสีเีดมิของ

ฉากหลงัตดิมาดวย ซึ่งจะตองแกไขใหเรยีบรอย

01 ใหนําภาพที่ตองการตัดตอมาวางซอนกันบนพาเนล Layers กอน หลังจากนั้นสราง Selection คลุมสวนที่จะ

นําไปใชงาน ซึ่งจากภาพตัวอยางผูเขียนใชวิธีสราง Selection ที่ทองฟากอนแลวจึงสลับ Selection โดยกดปุม

 +  + I  ไปที่ตวัมงักร เมื่อเรยีบรอยแลวคลกิปมุ Refine Edge บนออปชนับาร
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04 ใชเครื่องมือ  (Refine 

Radius Tool) แดรกเมาส

ไปบนเสนขอบที่มีสีของฉากหลังเดิม

ติดมา เมื่อปลอยเมาสเราก็จะเห็นวา

เสนขอบเหลานั้นถูกลบไปทนัที

ใชเครื่องมือ  (Refine Radius 

Tool) แดรกเมาสที่ขอบของภาพเพื่อ

ปรบัปรงุขอบ Selection จนทั่วทั้งภาพ 

ซึ่งขณะใชงานเครื่องมือนี้เราสามารถ

เพิ่ม หรือลดขนาดหัวแปรงไดโดย

กดปมุ  หรอื  

05 หลงัจากที่ใชเครื่องมอื  (Refine Radius Tool) แดรกเมาสที่ขอบของ

ภาพจนทั่วแลว ขั้นตอไปคอืการเกบ็รายละเอยีด โดยปรบัคาตางๆ ของ

คาํสั่ง เชน เพิ่มคา Smooth เพื่อใหขอบ Selection ไมเปนหยกัมากเกนิไป, ปรบัคา 

Feather เพื่อใหขอบฟุงเลก็นอย, ปรบัคา Contrast เพื่อใหขอบ Selection ชดัเจนขึ้น 

ลดคา Shift Edge ลงเลก็นอย เพื่อลดขอบสขีองภาพเกาที่ตดิมา เปนตน

06 คลิกเลือก Decontaminate Colors พรอมกับเพิ่มคา Amount ซึ่งจะ

เปนการกระจายสขีองภาพออกไปที่เสนขอบ เมื่อพอใจกบัผลลพัธแลว

ใหเลอืกรูปแบบผลลพัธในสวนของ Output To แลวคลกิปมุ OK

เมื่อปรบัปรงุ Selection ดวยคาํสั่ง Refine Edge เปนที่เรยีบรอยกจ็ะชวยใหการ

ทํางานในขั้นตอไปสะดวกขึ้น ภาพผลลัพธออกมาสมจริง สวยงามสมบูรณแบบ

ดงัตวัอยาง

เมื่อเพิ่มคา Amount ในสวน Decontaminate 
Colors แลวจะเห็นวาสีของภาพจะกระจาย
ไปบนเสนขอบดวย ทําใหผลลัพธออกมา
สมบูรณขึ้น
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จัดการกับเสนขอบภาพดวยคําสั่งในกลุม Matting

ปรับปรุงสีสันและแสงเงาของภาพ
ใน Photoshop จะมีคําสั่งสําหรับปรับปรุงสีสันและ

แสงเงาของภาพอยู่นับสิบคําสั่ง แต่มีสิ่งหนึ่งที่ต้องทําความ
เข้าใจคือ คาํสั่งเหลา่นี�สามารถเรยีกใช�งานไดจ้าก 2 วธีิ วธีิแรก
คือการเรียกใช�ผ่านเมนู Image > Adjustments โดยคําสั่ง
เหล่านี�จะเป�นการเข้าไปทํางานกับภาพโดยตรง หากมีความ
ผิดพลาดอาจแก้ไขได้ยาก แต่ก็มีข้อดีคือ โครงสร้างเลเยอร์
จะไม่ซับซ�อน สามารถทํางานอื่นๆ ต่อได้ทันที

การเรียกใชงานคําสั่งผานเมนู Image > 
Adjustmens จะเปนการใชคําสั่งทํางานกับ

ภาพโดยตรง

• Color Decontaminate ใชเกลี่ยสขีองภาพไปยงัเสนขอบ แตจะใชไดกบัภาพที่สราง Layer Mask เทานั้น

• Defringe ใชตดัสทีี่ตดิอยูบนเสนขอบออกไป โดยการระบคุวามหนาไดเอง

• Remove Black Matte ใชตดัขอบสดีาํที่ตดิมาบนภาพ

• Remove White Matte ใชตดัขอบสขีาวที่ตดิมาบนภาพ

จัดการกับ Selection ดวยคําสั่งในกลุม Modify
ในขณะที่เรากําลังทํางานกับ Selection อยู่เราสามารถปรับปรุง Selection นั�นใหม่ได้ 

ไม่ว่าจะเป�นการลดความหยักของ Selection หรือเพิ่มความฟุ้ง โดยใช�คําสั่งในกลุ่ม Modify 
ที่เรียกใช�ได้โดยคลิกเมนู Select > Modify ซ่ึงมีอยู่ 5 คําสั่ง ได้แก่

• Border ใชสาํหรบัสรางเสนขอบของ Selection

• Smooth ใชสาํหรบัลดความหยกัของเสน Selection

• Expand ใชสาํหรบัเพิ่มระยะของ Selection ออกไปดานนอก

• Contract ใชสาํหรบัลดระยะของ Selection ใหเขาดานในของวตัถทุี่เราสราง Selection ไว

• Feather ใชเพิ่มความฟุงให Selection มคีวามนุมนวลขึ้น

ในกรณีที่เรา Selection ภาพแล้วนําไปวางซ�อนบนฉากหลังใหม่แล้วพบว่า ยังมีสีของ
ภาพเดมิตดิมาดว้ย ถึงแมว้า่เราจะสรา้ง Selection ไดด้ขีนาดไหนกต็าม เราสามารถแก้ไขได้โดย
ใช�คําสั่งในกลุ่ม Matting ที่เรียกใช�ได้โดยคลิกเมนู Layer > Matting ซ่ึงมีอยู่ 4 คําสั่ง ได้แก่
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Intro

วิธีที่ สองของการปรับปรุง
สสีนั และแสงเงาของภาพคอืการเรยีก
ใช�คําสั่งผ่านพาเนล Adjustments 
ซ่ึงมีข้อดีกว่าตรงที่คําสั่งเหล่านี�จะ
ถูกสร้างเป�นเลเยอร์ใหม่ขึ�นมา ทําให้
สามารถปรับเปลี่ ยนค่าได้ตลอด
โดยไม่สร้างความเสียหายใดๆ ให้
แก่ภาพ

ขอ้ดอีกีอย่างของการเรียกใช�คาํสั่งผา่นพาเนล Adjusments คอื เราสามารถใช�เครื่องมอื  (Brush Tool) ระบายสดีาํ
หรือสีขาวลงไปใน Adjustment Layer เพื่อควบคุมขอบเขตของคําสั่งได้เช่นเดียวกับการทํางานกับ Layer Mask นั่นเอง

เมื่อคลิกปุมคําสั่งจากพาเนล Adjustments 
แลวจะปรากฏพาเนล Properties ขึ้นมา

เพื่อใชควบคุมคาของคําสั่ง
ที่เลือก และเมื่อสังเกตที่พาเนล Layers ก็
จะพบกับเลเยอรคําสั่งที่เราเลือกทํางาน 

ซึ่งสามารถลบทิ้ง หรือเปลี่ยนแปลงคาได
ตามความตองการ

ตัวอยางการทํางานโดยใชคําสั่ง Levels จากพาเนล Adjustments 
ปรับแสงของภาพใหมืดลง ซึ่งเราจะเห็นวาหลังจากใชคําสั่งจะปรากฏ 
Adjustment Layer บนพาเนล Layers ดวย

เมื่อใชเครื่องมือ  (Brush Tool) ระบายสีดําลงบน Adjustment 
Layer เราก็จะพบวาสามารถซอนขอบเขตของคําสั่ง Levels ได และ
หากตองการเพิ่มหรือลดความสวางก็สามารถทําไดอีกเชนกัน 
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คําสั่งสําหรับปรับสีสัน แสงเงาที่นาสนใจ
ในเรื่องของการรีทัชภาพ การปรับสีสัน และแสงเงาคือเรื่องที่สําคัญ เพราะนอกจากจะช่วยเพิ่มมิติให้ภาพแล้ว ยังช่วย

ควบคุมโทนอารมณ์ภาพ และสีสันของวัตถุแต่ละชิ�นที่ใส่ลงไปให้มีสีสันที่ใกล้เคียงกัน ซ่ึงใน Photoshop นั�นมีคําสั่งที่ทํางาน
ลักษณะนี�อยู่มากมาย แต่จะมีคําสั่งที่ใช�งานอยู่บ่อยๆ ดังนี�

ควบคุมความสวางดวย   Levels

Levels เป�นคําสั่งใช�แก้ไขความมืดหรือสว่างของภาพ ซ่ึงเราสามารถกําหนดจุดมืด-สว่าง รวมถึงความสว่างโดยรวม
ของภาพได้ เราสามารถเรียกใช�คําสั่งได้ เมื่อต้องการใช�งานคําสั่งนี�ทําได้โดยคลิกปุ่ม  บนพาเนล Adjustments หรือคลิก
เมนู Image > Adjustments > Levels ซ่ึงมีส่วนประกอบสําคัญ ดังนี�

เลือกปรับแตงแสง
แบบแยก Channel

ขาลากปรับแตง
แสง-เงา

คา Output Levels ที่ใชกําหนดความ
เขมของสีดําและสีขาวซึ่งจะใชงานคอน

ขางบอยในกระบวนการรีทัชภาพ

เครื่องมือกําหนดจุด
ที่มืด-สวางของภาพ

การปรบัแตงแสงเงาดวยคาํสั่ง Levels คอื ขาลากที่ใช

ควบคมุแสงเงามอียู 3 ตวัดวยกนั เมื่อมกีารปรบัแตงขาลาก

อนัใดอนัหนึ่ง แสงเงาของภาพกจ็ะเปลี่ยนไปดวย

Shadows 
ใชเพิ่มความ
เขมของเงา

Midtones ใช
เพิ่มความมืด

หรอืความสวาง
ใหโทนกลาง

ของภาพ

Highlights 
ใชเพิ่มความ

สวางใหไฮไลท

จากตัวอยางการทํางานนี้จะพบวา เราสามารถปรับแสงเงาขององคพระใหเขมขึ้นไดดวยคําสั่ง Levels โดยแดรกเมาสที่ขาลากของคําสั่งจนไดแสงเงาที่
ตองการ (ภาพขวา)

ภาพตนฉบับ
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